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1.8 - LAYERS, DIMENSIONING AND TEXT - OH MY! 

LESSON 1-1 Introduction to AutoCAD 

LESSON 1-2 ASSIGNMENT 1 INTRO TO DRAWING / 
MODIFYING COMMANDS

LESSON 1-3 ASSIGNMENT 2 MORE MODIFYING COMMANDS / 
OBJECT SNAPS 

LESSON 1-4 ASSIGNMENT 3 ACCURATE INPUT 

LESSON 1-5 SELECTION SETS

LESSON 1-6 ASSIGNMENT 4 MODIFYING COMMANDS

LESSON 1-7 ASSIGNMENT 5 MODIFYING COMMANDS 

LESSON 1-8 ASSIGNMENT 6 LAYERS / DIMENSIONING / TEXT / 
SCALE 

LESSON 1-9 DIRECT DISTANCE ENTRY AND OBJECT 
TRACKING 

LESSON 1-10 CHANGING THE PROPERTIES OF OBJECTS

LESSON 1-11 ZOOMING AND PANNING AROUND A DRAWING

 
Topics covered in this Lesson:
Layer, Text, Dimensioning, Scale 

Now that you've learned a lot of the drawing and modifying commands, it's time to go to the next level. This 
lesson will introduce you to text, dimensioning and the concept of layers. What you will do is take one of your 
previous assignments, save it to a new name and then add text and dimensions to it. These are the 
commands you'll be learning.

Command Keystroke Icon Menu Result

Layer Layer / LA Format > Layer Starts the Layer 
and Linetype 
property dialog 
box

Text Text No Icon Draw > Single Line 
Text

Creates a single 
line of text

Dimension Dim Many Dimension > (pick 
one)

Dimensions 
previously drawn 
objects

Scale Scale / SC Modify > Scale Proportionately 
resizes (or 
scales) objects

Begin by opening up Assignment #5 from your CAD folder.

Using the SAVE AS  option, immediately save it under the name Assign6.dwg
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Click HERE for the GIF version of the file. 
Click HERE for the DWG version.

The first thing you want to do is create three layers. Layers are used to organize drawings. Imagine a large 
project for a high-rise tower. The designers would create layers for the electrical, plumbing, landscape and 
more. It is necessary to control the drawing and turn some layers off and view only the ones you want. This is 
one reason why layers are needed. But if you were to use AutoCAD professionally, every drawing you dealt 
with would have layers. 

You will be creating a layer for the dimensions, one for the lines (objects that were drawn) and another for the 
text. Start the LAYER command (LA). This will bring up the Layer Properties Manager (shown below). We'll 
cover the things that are used most often in this lesson. 

Looking at the Dialog Box, you will see a lot of information. Notice the button beside Make Current on it. 
Below it is the name of the current layer you are drawing on. The main window gives you information about 
each particular layer. At this point, you want to be concerned with the 'Name', 'On' (light bulb) and 
'Color' (colored square) columns as well as the 'New' button. 

Now you have the dialog box on your screen, click the 'New' button. This will create a new layer and give you 
an opportunity to name it. Name this layer TEXT. Click on the small box towards the right and select yellow 
for the color. Create another layer and call this one DIM (for dimensions), and make its color red. Finally, 
create a third layer and call it OBJECT and make its color green. You have just created three new layers in 
your drawing. Highlight the TEXT layer and then press the 'Make Current' button. This makes the TEXT layer 
current and anything you draw will be placed on that layer. Your Dialog box should look like the one above. If 
it does, press OK to close the dialog box.

More about Layers 

In the Layer Properties Manager, you will notice that each layer can have a number of specific properties. 
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●     Status: Displays the current state of the layer. In this example, the green check means that Objects is 
the current layer.

●     Name: The name of the layer. Give layers understandable names.

●     On: If a layer is 'On' it means that it is visible (but objects can still be erased when the 'Select > All 
option is used).

●     Freeze: A layer is not visible and cannot be deleted.

●     Lock: Layer is visible, but cannot be modified.

●     Color: A specific color for everything on that layer.

●     Linetype: A specific linetype (hidden, center, etc) for the layer.

●     Lineweight: The visible width of the objects on that layer.

●     Plot: A defined color for the plotter to use on that layer.

●     Plot (yes, two colomns use the same name: Switch on or off if that layer is plotted.

●     Description: A user-defined description for the layer. 

ADDING TEXT 

TEXT is your current drawing layer now, so what you will be doing is creating some text now. Type in TEXT 
on the command line. Look at the command line.

Command: text
Justify/Style/<Start point>: 

The first thing AutoCAD wants is a starting point for the text. Type: 0,0 to place it at the bottom left corner of 
your drawing. Notice that there are other options you could make, but ignore them for now.

Height <0.2000>: 

Next, AutoCAD wants to know how tall you want your letters to be. For this assignment, you want them to be 
1/4" tall. Type in .25 at the Height prompt.

Rotation angle <0>:

One more thing before you start typing in text, tell AutoCAD if you want to have your text rotated. Not this 
time, so press <ENTER> to accept the default of 0 degrees.

Text: (YOUR NAME - ASSIGNMENT #6)

Finally you can type in what you want to put on the drawing. At the prompt, type your NAME and 

ASSIGNMENT #6  then press <ENTER>. 

You will see that AutoCAD has placed your name in the bottom left corner at 1/4" high and in yellow on the 
'Text' layer.

You don't really want your name jammed into the corner like that so move it up and over 1/8" (Remember 
your MOVE command and relative points : @.125,.125)

file:///C|/Documents%20and%20Settings/User/Desktop/...20-%20Layers%20and%20Dimensioning%20-%20AutoCAD.htm (3 of 6)04/12/1429 11:24:03 •



Free CAD Lessons and Tutorials - Lesson 1-8 - Layers and Dimensioning - AutoCAD

Now it's time to start dimensioning your drawing. Bring up the Layer dialog box and make DIM your current 
layer. 

This is one time when I recommend to use the icons. Dimensioning is A LOT easier this way. If you don't see 
your dimensioning toolbar on the screen, right click on one of your toolbar icons and check the Dimension 
checkbox. You'll see the toolbar appear. Close the Toolbars dialog box.

There are several different types of dimensions, here are the ones you'll be using in this lesson (Each of the 
dimensioning icons gives you a quick clue as to which type of dimension it will create.) The image below 
shows you the standard dimensioning icons. This list below shows you which dimension types you will use in 
this lesson (Place your mouse on the toolbar icons to see what they represent.

Here are the ones you'll be using in this lesson. 

Linear dimensions are used for dimensioning either horizontal or vertical distances. 

Aligned dimensions will measure the actual length of an angled line.

Radius dimensions will give you the radius of either arcs or circles.

Diameter dimensions are used on circles.

Angular dimensions will measure the angle between two lines that you pick.

Baseline dimensions are a special type that will automatically stack dimensions along one plane as you pick 
points.

The type of dimension you pick will depend entirely upon what information you want to convey to the person 
reading the drawing. Look at the sample drawing and pick out the different types of dimensions and where 
they are used.

We'll start with the most common (and easiest): Linear Dimensions. You'll use this type to add dimensions 
to the rectangle in the bottom left of your drawing. Pick on the icon and then look at the command line.

Command: _dimlinear
Specify first extension line origin or <select object>:

It asks for either the origin of the first dimension line (a starting point) or you can press <ENTER> to select a 
particular line. Turn your OSNAPS on to endpoint only. Pick the top left corner of the rectangle. AutoCAD 
then asks for the second extension line origin. Pick the top right corner. You'll then see the dimension appear 
and AutoCAD asks for the Dimension line location. Pick somewhere just above the line where you think it fits 
well.

AutoCAD then shows you the length that it found to be the length of the line you just dimensioned. The 
following lines show what you should have seen on your command line:

Specify second extension line origin: <SELECT TOP RIGHT CORNER>
Specify dimension line location or
[Mtext/Text/Angle/Horizontal/Vertical/Rotated]: <PICK ABOVE THE LINE>
Dimension text = 3.000

Now dimension the line on the left side using the same method.

Now you want to dimension the radius of the fillet on the object above the first box. Pick the icon for radius 
dimension. AutoCAD asks you to select an arc or circle. Pick the arc on the top left corner. Again AutoCAD 
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then wants you to pick the dimension line location. Pick anywhere outside the arc where the dimension fits 
well.

Looking at the top left object on the sample sheet, notice that there are a few ways to dimension the corners. 
Start on the bottom left. Pick the Linear Dimension icon. Instead of picking the two endpoints, press 
<ENTER> and AutoCAD will ask you to select the object you want to dimension. Pick on the angled line in 
the bottom left corner. As you move your cursor around, you'll see that you could place it either to the left or 
below the line. Choose one or the other and place your dimension. Repeat these steps to add the other 
dimension.

At the top left, you want to add an Aligned dimension. Pick the icon for this. As with the linear dimensions, 
you can either pick the endpoints or press <ENTER> to choose and object. When you're asked to place the 
dimension, you'll see that you can only move parallel to the line that you picked. Place the dimension line 
somewhere outside the object.

Now you're going to dimension the angle on the bottom right corner of the top box. Pick the Angular 
dimension icon. Pick the bottom line and then the angled line in the bottom right corner. Place the dimension 
so that it looks like the one in the sample.

Now its time to dimension the circle. Pick the icon for the Diameter dimension. AutoCAD then wants you to 
select the arc or circle. Pick anywhere on the circle. Then you have to place the dimension line somewhere. 
Pick a good spot for it.

Dimension the 1" line in the circle as shown using a linear dimension.

Dimension the top left box of the array as shown using Linear dimensions.

Dimension the space (0.75) between the two rows by picking the endpoints of the lines.

Dimension the space (0.75) between the columns as shown.

Now for the tricky part. You want to add baseline dimensions to the column distance dimension you just 
created. Pick the icon for the baseline dimensions. Look at the command line:

You may be asked to select the base dimension. If so, pick on the 0.75 dimension for the column. Then 
you're asked to Specify a second extension line origin. Pick where P1 shows you on the sample drawing. 
AutoCAD then will get you to keep repeating this process until you press <ENTER> to end the command. 
Pick near P2 to continue, then press <ENTER>. This is what your command line should have looked like:

Command: _dimbaseline
Select base dimension:
Specify a second extension line origin or (Undo/<Select>):<pick P1>
Dimension text = 1.50
Specify a second extension line origin or (Undo/<Select>): <pick P2>
Dimension text = 2.00
Specify a second extension line origin or (Undo/<Select>): <ENTER>

Your drawing should now look similar to the sample drawing. Check to see if you missed any dimensions. 

Now you have dimensioned the drawing, save it and print it.

Next you want to copy everything over 12" to the right. Start the COPY command, and when asked to select 
objects, type ALL <ENTER>. Then copy it all 12" to the right.

What you want to do next is scale the copy of everything to double its existing size. Start the SCALE 
command. When asked to select objects, draw a window around the new set of objects and press <ENTER>. 
When asked for a base point, pick the bottom left corner of the border. Enter 2 for the scale factor. Your 
command line should look like this:
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Command: sc
SCALE
Select objects: Other corner: 38 found
Select objects:<ENTER>
Base point:<PICK THE BOTTOM LEFT CORNER)
<Scale factor>/Reference: 2 <ENTER>

Perform a Zoom Extents (type Z <ENTER> E <ENTER>) at the command line. Now that everything is twice 
as large, Zoom in on your dimensions and you'll see that they have automatically adjusted to the new sizes! 
This is called associative dimensioning.

There are many different parameters you can change to get just the right look for your dimensions and text 
(use the DDIM command). This is will not be covered in this course.

For practice, you can try dimensioning some of your other assignments.

Even if your drawing is 100% accurate, it is still only as good as the dimensions. Some common mistakes 
when dimensioning are:

●     Not using your Osnaps. If you don't get the exact endpoint of a line, then your dimension is wrong.

●     Snapping to the wrong point. In detailed drawings, this can be easy to do if you aren't paying attention.

●     Incomplete dimensions. If you miss one or two dimensions, you can delay the project while these 
numbers are located, new drawings made, delivered, etc..

●     Confusing dimensions. Make sure that your dimensions don't overlap, or aren't too close, or otherwise 
unclear. 

 View the video for Assignment 6 . 

For dimensioning practice, dimension the extra lessons from the previous lessons. Also put objects and 
dimensions on separate layers.

Extra_001.gif Extra_002.gif Extra_003.gif Extra_004.gif Extra_005.gif

Extra_006.gif Extra_007.gif Extra_008.gif Extra_009.gif Extra_010.gif

Extra_011.gif Extra_012.gif    

RETURN TO THE TOP OF THE LESSON | RETURN TO THE TABLE OF CONTENTS

CONTINUE TO THE NEXT LESSON - 1-9 > 

Take the quiz for this lesson

Owned and operated by Art Whitton, Chester, NE 
This web site is protected by Copyright 1999-2008© Last Update: 
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